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1 Modifikationen 

Version Änderungen 

2 23.10.2012: Erstellung des Dokuments 

2.1 23.10.2012: Version für das Internet 

2.2 18.11.2013: Preservation Metadata NLNZ: URL in Kapitel 4 und 6.3.1 aktuali-

siert 

2.3 08.05.2014: 

- Kapitel 6.2: Anpassung des Encoding Levels (Position 17) im marc:leader und 

Ergänzung des Feldes 082 74 (Dewey) in den Beispielen 

- Kapitel 6.3.1, zweites <nlnz:Type>URL for URN registration: Bezeichnung des 

URL-Typs in <nlnz:Purpose> angepasst 

2.4 23.08.2016: Preservation Metadata NLNZ: URL in Kapitel 4 und 6.3.1 aktuali-

siert 

2.5 30.10.2017: Kapitel 6.2, URLs in der ersten Fussnote aktualisiert 

2.6 Anpassungen an Alma und RDA, sowie weitere formale Anpassungen 
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2 Zweck des Dokuments 

Dieses Dokument erklärt das interne Datenformat der Schweizerischen Nationalbibliothek (NB), das 

auf dem Standard METS (Metadata Encoding & Transmission Standard, Version 1.3) basiert. Die Ab-

weichungen zu METS werden beschrieben sowie die Verwendung der einzelnen Elemente von METS 

in der NB.  

 

3 Vorbemerkung 

Der Datensatz muss immer in xml mit UTF-8 geschrieben werden. Das interne Datenformat basiert 

auf dem METS-Standard (Version 1.3). Für die bibliografischen Metadaten wird MARCxml verwendet. 

Für die technischen Metadaten werden die Preservation Metadata der National Library of New Ze-

aland (Version Juli 2003) gebraucht. 

 

Das Metadatenschema ist auf der Website der NB veröffentlicht:  

http://www.nb.admin.ch/standards/slb/slb.xsd (Hauptschema -> METS-Container)  

http://www.nb.admin.ch/standards/slb/MARC21/MARC21slim.xsd (MarcXML)  

http://www.nb.admin.ch/standards/slb/presmet/nlnz_presmet.xsd (Metadaten-Schema Neuseeland, 

Hauptschema)  

http://www.nb.admin.ch/standards/slb/presmet/nlnz_file.xsd (Metadaten-Schema Neuseeland, Unter-

schema für Files und Folders)  

http://www.nb.admin.ch/standards/slb/presmet/nlnz_types.xsd (Metadaten-Schema Neuseeland, Da-

tentypen)  

 

Sie basieren auf folgenden Subschemata: nlnz_presmet.xsd, nlnz_files.xsd und nlnz_types.xsd sowie 

marc21slim.xsd. Die Beschreibung dazu befindet sich unter den folgenden Links:  

 

Metadata and Encoding and Transmission Standard (METS) der Library of Congress 

http://www.loc.gov/standards/mets/ 

MARCXML der Library of Congress 

http://www.loc.gov/standards/marcxml/ 

Preservation Metadata der National Library of New Zealand: 

http://digitalpreservation.natlib.govt.nz/assets/NDHA/Reading/metaschema-revised.pdf  

 

 

4 Publikationstypen 

Momentan sind folgende Publikationstypen in der NB archiviert: 

 

 Online-Zeitschrift und Online-Reihe 

 Online-Zeitschriftennummer 

 Online-Monografie 

 Titel der Website 

 Version der Website 

 

Diese Liste ist erweiterbar. 

 

 

http://www.nb.admin.ch/standards/slb/slb.xsd
http://www.nb.admin.ch/standards/slb/MARC21/MARC21slim.xsd
http://www.nb.admin.ch/standards/slb/presmet/nlnz_presmet.xsd
http://www.nb.admin.ch/standards/slb/presmet/nlnz_file.xsd
http://www.nb.admin.ch/standards/slb/presmet/nlnz_types.xsd
http://www.loc.gov/standards/mets/
http://www.loc.gov/standards/marcxml/
http://digitalpreservation.natlib.govt.nz/assets/NDHA/Reading/metaschema-revised.pdf
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5 METS-Elemente 

Das xml-Schema des METS-Containers wird immer wie folgt eingeleitet (Reihenfolge der Referenzen 

kann varieren): 

 

<?xml version="1.0" encoding="UTF-8"?> 

<slb xmlns:xs="http://www.w3.org/2001/XMLSchema"  

xmlns:marc="http://www.loc.gov/MARC21/slim" xmlns:nb="http://www.nb.ad-

min.ch/function" xmlns:a="http://www.loc.gov/mods/v3" 

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

xmlns:xlink="http://www.w3.org/TR/xlink" xmlns="http://www.nb.ad-

min.ch/standards/slb" xsi:schemaLocation="http://www.nb.admin.ch/stan-

dards/slb http://www.nb.admin.ch/standards/slb/slb.xsd" 

xmlns:nlnz="http://www.natlib.govt.nz/presmet"> 

 

 

5.1 metsHdr 

Im metsHdr wird der METS-Datensatz selber beschrieben. Als ID wird eine fortlaufende Verarbei-

tungs-ID vergeben, weil das AIP im Verarbeitungsprozess erst später den Identifikator bekommt und 

trotzdem von Anfang an identifizierbar sein muss. Das Erstellungsdatum (createdate) entspricht dem 

Datum, an dem der METS-Datensatz hergestellt wurde. Bei jeder Änderung wird das lastmoddate 

ausgefüllt. Im Recordstatus erscheint der Zustand des Prozessablaufs. Am Schluss steht hier ein 

„completed“. 

 

Die Elemente Agent und altRecordID werden nicht verwendet, da der Prozess in den techMD im Ele-

ment Process abgehandelt wird.  

 

Der metsHdr ist für alle Publikationstypen gleich: 

 

<metsHdr ID="Rec1" CREATEDATE="yyyy-mm-ddThh:mm:ss" LASTMODDATE="yyyy-mm-

ddThh:mm:ss" RECORDSTATUS="completed"> 

</metsHdr> 

 

 

5.2 dmdSec 

Die bibliografischen Metadaten werden in MARCxml nach den Katalogisierungsregeln der NB1 abge-

bildet. Dabei wird die Struktur von MARCxml2 eingehalten. 

 

Damit es keinen Konflikt mit der Codierung von METS und den Preservation Metadata der National 

Library of Zealand gibt, wird ein marc vor dem Elementnamen eingefügt. 

 

Die Metadaten werden in das Element marc:collection, Unterelement marc:record eingegeben. Das 

Element marc:record wird nicht als Basiselement für MARCxml angewendet. 

 

                                                   

1 http://ead.nb.admin.ch/web/marc21/dmarceinl2.htm  (MARC21) und  

https://www.nb.admin.ch/snl/de/home/fachinformationen/erschliessen/formalerschliessung.html#269433168 (RDA NB Zusatzre-

gelungen) 

2 http://www.loc.gov/standards/marcxml/schema/MARC21slim.xsd 

https://www.nb.admin.ch/snl/de/home/fachinformationen/erschliessen/formalerschliessung.html#269433168
http://www.loc.gov/standards/marcxml/schema/MARC21slim.xsd
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Die Elemente marc:leader und die marc:controlfield tag 003, 007, 008 sowie marc:datafield 0243, 040, 

336, 337, 338, 500, 856 4, 856 42, 992 sind Einträge, die nicht aus der Lieferanten-Metadaten-Liefe-

rung stammen und per Programm automatisch generiert werden müssen.  

Die Elemente marc:controlfield 001 und 005 sowie marc:datafield 039 werden erst in ALMA automa-

tisch generiert und sind deshalb im METS-Dokument nicht vorhanden. 

Der Inhalt des Elements marc:controlfield 001 (Systemnummer) wird durch das Logfile, das bei der 

Übermittlung der Daten in Helveticat entsteht, bekannt gemacht und dabei in das METS übertragen. 

Alle anderen Elemente kommen aus den Lieferanten-Metadaten-Lieferungen. 

 

Der marc:leader pro Publikationstyp besteht aus 24 Positionszeichen und wird standardisiert vermerkt: 

 

 Online-Zeitschrift/Reihe: 01084nas#a22003017i#4500 
 Online-Zeitschriftennummer: 00253nyma22001214n#4500 

 Online-Monografie: 01430nam#a22003617i#4500 

 Titel der Website: 01431nai#a22003977i#4500 

 Version der Website: 00253nym#a22001214n#4500 

 

Das Element marc:datafield tag=“007“ besteht aus 14 Positionszeichen und wird standardisiert für alle 

Publikationstypen gleich vermerkt (bei der Online-Zeitschriftennummer und der Version der Website 

entfällt dieses Feld): 

 

 Online: cr#||||||||||| 

 Diskette: cj#||||||||||| 

 CD-ROM: co#||||||||||| 

 

Das Element marc:datafield tag=“008“ besteht aus 40 Positionszeichen und wird standardisiert ver-

merkt. Das Jahr (JJJJ) und die Sprache (hier in den Beispielen ger) stammen von der Lieferanten-Me-

tadaten-Lieferung. JJMMTT entspricht dem Datum der Erstellung des METS. 

 

 Online-Zeitschrift/Reihe: JJMMTTcJJJJ9999sz#an###s######000###ger#d 

 Online-Zeitschriftennummer: - 

 Online-Monografie: JJMMTTsJJJJ####sz######s#####000#0#ger#d 

 Titel der Website: 051107c20039999sz#uu###s#####000###ger#d 

 Version der Website: -  

 

Für alle Publikationstypen gleich: 

 

<dmdSec ID="dmd0014"> 

<mdWrap MDTYPE="OTHER" OTHERMDTYPE="MARCXML"> 

<xmlData> 

<marc:collection> 

<marc:record> 

 

</marc:record> 

</marc:collection> 

</xmlData> 

</mdWrap> 

</dmdSec> 

 

Innerhalb des marc:record erscheinen für die einzelnen Publikationstypen folgende Elemente: 

 

Online-Zeitschrift: 

                                                   

3 Ausnahme: Das Feld 024 wird von Lieferanten, die eine DOI oder eine URN vorgängig vergeben, übermittelt.  

4 Fortlaufende Identifikationsnummer: siehe unter Punkt 6.8 



 

    

   6/21 

SLB METS 2.6 Version Internet 

 

 

<marc:leader>01084nas a22003017i 4500</marc:leader> 

<marc:controlfield tag="001"> 991017979927403976</marc:controlfield> 

<marc:controlfield tag="003">Sz</marc:controlfield> 

<marc:controlfield tag="007">c r</marc:controlfield> 

<marc:controlfield tag="008">JJMMTTcJJJJ9999sz br p s     0   a0eng 

d</marc:controlfield> 

<marc:datafield tag="022" ind1="0" ind2=" "> 

<marc:subfield code="a">ISSN</marc:subfield> 

<marc:subfield code="2">40</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="024" ind1="7" ind2=" "> 

<marc:subfield code="2">URN</marc:subfield> 

<marc:subfield code="a">urn:nbn:ch:@URNID@</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="040" ind1=" " ind2=" "> 

<marc:subfield code="a">Sz</marc:subfield> 

<marc:subfield code="b">Beschreibungssprache</marc:subfield> 

<marc:subfield code="e">rda</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="082" ind1="7" ind2="4"> 

<marc:subfield code="a">Dewey</marc:subfield> 

<marc:subfield code="2">23sdnb</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="245" ind1="0" ind2="0"> 

<marc:subfield code="a">Titel</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="264" ind1=" " ind2="1"> 

<marc:subfield code="a">Erscheinungsort : </marc:subfield> 

<marc:subfield code="b">Verlag, </marc:subfield> 

<marc:subfield code="c">Jahr-</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="336" ind1=" " ind2=" "> 

<marc:subfield code="b">txt</marc:subfield> 

<marc:subfield code="2">rdacontent</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="337" ind1=" " ind2=" "> 

<marc:subfield code="b">c</marc:subfield> 

<marc:subfield code="2">rdamedia</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="338" ind1=" " ind2=" "> 

<marc:subfield code="b">cr</marc:subfield> 

<marc:subfield code="2">rdacarrier</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="500" ind1=" " ind2=" "> 

<marc:subfield code="a">Titel und Beschreibung vom Lieferanten 

(TT.MM.JJJJ)</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="516" ind1=" " ind2=" "> 

<marc:subfield code="a">application/PDF</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="856" ind1="4" ind2="0"> 

<marc:subfield code="u">Original-URL</marc:subfield> 

</marc:datafield> 
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<marc:datafield tag="856" ind1="4" ind2=" "> 

<marc:subfield code="u">http://nbn-resolving.de/urn/re-

solver.pl?urn=urn:nbn:ch:@URNID@</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="856" ind1="4" ind2="2"> 

<marc:subfield code="u">http://www.e-helvetica.nb.admin.ch/directAc-

cess?callnumber=@URNID@</marc:subfield> 

<marc:subfield code="y">2</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="991" ind1=" " ind2=" "> 

<marc:subfield code="a">xefpubl</marc:subfield>  

<marc:subfield code="b">JJJJ</marc:subfield>  

</marc:datafield> 

<marc:datafield tag="992" ind1=" " ind2=" "> 

<marc:subfield code="a">xehelv</marc:subfield><marc:subfield 

code="b">xpop</marc:subfield><marc:subfield code="c">JJJJ</marc:sub-

field><marc:subfield code="d">Dewey</marc:subfield><marc:subfield 

code="e">Lieferantencode</marc:subfield> 

</marc:datafield> 

 

 

Online-Reihe: 

 

<marc:leader>01084nas a22003017i 4500</marc:leader> 

<marc:controlfield tag="001"> 991017984926103976</marc:controlfield> 

<marc:controlfield tag="003">Sz</marc:controlfield> 

<marc:controlfield tag="007">c r</marc:controlfield> 

<marc:controlfield tag="008">JJMMTTcJJJJ9999sz  x m s     0   a0eng 

d</marc:controlfield> 

<marc:datafield tag="022" ind1="0" ind2=" "> 

<marc:subfield code="a">ISSN</marc:subfield> 

<marc:subfield code="2">40</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="024" ind2=" " ind1="7"> 

<marc:subfield code="2">URN</marc:subfield> 

<marc:subfield code="a">urn:nbn:ch:@URNID@</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="040" ind1=" " ind2=" "> 

<marc:subfield code="a">Sz</marc:subfield> 

<marc:subfield code”b”>Beschreibungssprache</marc:subfield> 

<marc:subfield code=”e”>rda</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="082" ind1="7" ind2="4"> 

<marc:subfield code="a">Dewey</marc:subfield> 

<marc:subfield code="2">23sdnb</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="090" ind1=" " ind2=" "> 

<marc:subfield code="i">s</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="245" ind1="0" ind2="0"> 

<marc:subfield code="a">Titel</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="264" ind1=" " ind2="1"> 

<marc:subfield code="a">Erscheinungsort : </marc:subfield> 
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<marc:subfield code="b">Verlag, </marc:subfield> 

<marc:subfield code="c">Jahr-</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="336" ind1=" " ind2=" "> 

<marc:subfield code="b">txt</marc:subfield> 

<marc:subfield code="2">rdacontent</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="337" ind1=" " ind2=" "> 

<marc:subfield code="b">c</marc:subfield> 

<marc:subfield code="2">rdamedia</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="338" ind1=" " ind2=" "> 

<marc:subfield code="b">cr</marc:subfield> 

<marc:subfield code="2">rdacarrier</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="500" ind1=" " ind2=" "> 

<marc:subfield code="a">Titel und Beschreibung vom Lieferanten 

(TT.MM.JJJJ)</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="516" ind1=" " ind2=" "> 

<marc:subfield code="a">application/PDF</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="856" ind1="4" ind2="0"> 

<marc:subfield code="u">Original-URL</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="856" ind1="4" ind2=" "> 

<marc:subfield code="u">http://nbn-resolving.de/urn/re-

solver.pl?urn=urn:nbn:ch:@URNID@</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="856" ind1="4" ind2="2"> 

<marc:subfield code="u">http://www.e-helvetica.nb.admin.ch/directAc-

cess?callnumber=@URNID@</marc:subfield> 

<marc:subfield code="y">2</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="991" ind1=" " ind2=" "> 

<marc:subfield code="a">xepubl</marc:subfield>  

<marc:subfield code="b">JJJJ</marc:subfield>  

</marc:datafield> 

<marc:datafield tag="992" ind1=" " ind2=" "> 

<marc:subfield code="a">xehelv</marc:subfield> 

<marc:subfield code="b">xpop</marc:subfield> 

<marc:subfield code="c">JJJJ</marc:subfield> 

<marc:subfield code="d">Dewey</marc:subfield> 

<marc:subfield code="e">Lieferantencode</marc:subfield> 

</marc:datafield> 

 

 

Online-Zeitschriftennummer: 

 

<marc:leader>00253nym a22001214n 4500</marc:leader> 

<marc:controlfield tag="001"> 991017979926903976</marc:control-

field> 

<marc:controlfield tag="003">Sz</marc:controlfield> 
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<marc:controlfield tag="004"> 991017979926903976</marc:control-

field> 

<marc:datafield tag="022" ind1="0" ind2=" "> 

<marc:subfield code="a">1423-0224</marc:subfield> 

<marc:subfield code="2">40</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="245" ind1="0" ind2="0"> 

<marc:subfield code="a">Titel</marc:subfield> 

</marc:datafield> 

 

 

Online-Monografie 

 

<marc:leader>01430nam a22003617i 4500</marc:leader> 

<marc:controlfield tag="001"> 991017979194503976</marc:controlfield> 

<marc:controlfield tag="003">Sz</marc:controlfield> 

<marc:controlfield tag="007">c r</marc:controlfield> 

<marc:controlfield tag="008">JJMMTTsJJJJ    sz      s     000 0 ger 

d</marc:controlfield> 

<marc:datafield tag="020" ind1=" " ind2=" "> 

<marc:subfield code="a">ISBN</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="024" ind1="7" ind2=" "> 

<marc:subfield code="2">DOI</marc:subfield> 

<marc:subfield code="a">10.1159/000074220</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="024" ind1="7" ind2=" "> 

<marc:subfield code="2">URN</marc:subfield> 

<marc:subfield code="a">urn:nbn:ch:@URNID@</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="040" ind1=" " ind2=" "> 

<marc:subfield code="a">Sz</marc:subfield> 

<marc:subfield code="b">Beschreibungssprache</marc:subfield> 

<marc:subfield code="e">rda</marc:subfield></marc:datafield> 

<marc:datafield tag="082" ind1="7" ind2="4"> 

<marc:subfield code="a">Dewey</marc:subfield> 

<marc:subfield code="2">23sdnb</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="245" ind1="0" ind2="0"> 

<marc:subfield code="a">Titel</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="250" ind1=" " ind2=" "> 

<marc:subfield code="a">1. Aufl.</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="264" ind1=" " ind2="1"> 

<marc:subfield code="a">Erscheinungsort :</marc:subfield> 

<marc:subfield code="b">Verlag, </marc:subfield> 

<marc:subfield code="c">Jahr</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="336" ind1=" " ind2=" "> 

<marc:subfield code="b">txt</marc:subfield> 

<marc:subfield code="2">rdacontent</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="337" ind1=" " ind2=" "> 
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<marc:subfield code="b">c</marc:subfield> 

<marc:subfield code="2">rdamedia</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="338" ind1=" " ind2=" "> 

<marc:subfield code="b">cr</marc:subfield> 

<marc:subfield code="2">rdacarrier</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="490" ind1="1" ind2=" "> 

<marc:subfield code="a">Reihentitel</marc:subfield><marc:subfield 

code="x">ISSN</marc:subfield><marc:subfield code="v">Bandnummer</marc:sub-

field> 

</marc:datafield>5 

<marc:datafield tag="500" ind1=" " ind2=" "> 

<marc:subfield code="a">Titel und Beschreibung vom Lieferanten 

(TT.MM.JJJJ)</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="516" ind1=" " ind2=" "> 

<marc:subfield code="a">application/PDF</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="700" ind1="1" ind2="0"> 

<marc:subfield code="a">Nachname, Vorname</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="830" ind1=" " ind2="0"> 

<marc:subfield code="a">Reihentitel</marc:subfield><marc:subfield 

code="v">Bandnummer</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="856" ind1="4" ind2="0"> 

<marc:subfield code="u">Original-URL</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="856" ind1="4" ind2="2"> 

<marc:subfield code="u">http://www.e-helvetica.nb.admin.ch/directAc-

cess?callnumber=@URNID@</marc:subfield> 

<marc:subfield code="y">2</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="856" ind1="4" ind2=" "> 

<marc:subfield code="u">http://nbn-resolving.de/urn/re-

solver.pl?urn=urn:nbn:ch:@URNID@</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="992" ind1=" " ind2=" "> 

<marc:subfield code="a">xehelv</marc:subfield><marc:subfield 

code="b">xpop</marc:subfield><marc:subfield code="c">JJJJ</marc:sub-

field><marc:subfield code="d">Dewey</marc:subfield><marc:subfield 

code="e">Lieferantencode</marc:subfield> 

</marc:datafield> 

 

 

Titel der Website: 

 

<marc:leader>01431nai a22003977i 4500</marc:leader> 

<marc:controlfield tag="001"> 991018008729403976</marc:controlfield> 

<marc:controlfield tag="003">Sz</marc:controlfield> 

<marc:controlfield tag="007">c r</marc:controlfield tag> 

                                                   

5 Das Kombinationsfeld 490/830 wird nur verwendet, wenn die Publikation in einer Reihe erscheint.  
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<marc:controlfield tag="008">JJMMTTcJJJJ9999sz uu wss     000  2ger 

d</marc:controlfield tag> 

<marc:datafield tag="024" ind1="7" ind2=" "> 

<marc:subfield code="2">URN</marc:subfield> 

<marc:subfield code="a">urn:nbn:ch:@URNID@</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="040" ind1=" " ind2=" "><marc:subfield 

code="a">Sz</marc:subfield> 

<marc:subfield code="b">Beschreibungssprache</marc:subfield> 

<marc:subfield code="e">rda</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="041" ind1="1" ind2=" "><marc:subfield 

code="a">ger</marc:subfield><marc:subfield code="a">eng</marc:sub-

field></marc:datafield> 

<marc:datafield tag="082" ind1="7" ind2="4"> 

<marc:subfield code="a">Dewey</marc:subfield> 

<marc:subfield code="2">23sdnb</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="245" ind1="0" ind2="0"> 

<marc:subfield code="a">Titel</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="264" ind1=" " ind2="1"> 

<marc:subfield code="a">Erscheinungsort :</marc:subfield> 

<marc:subfield code="b">Verlag, </marc:subfield> 

<marc:subfield code="c">Jahr-</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="336" ind1=" " ind2=" "> 

<marc:subfield code="b">txt</marc:subfield> 

<marc:subfield code="2">rdacontent</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="337" ind1=" " ind2=" "> 

<marc:subfield code="b">c</marc:subfield> 

<marc:subfield code="2">rdamedia</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="338" ind1=" " ind2=" "> 

<marc:subfield code="b">cr</marc:subfield> 

<marc:subfield code="2">rdacarrier</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="500" ind1=" " ind2=" "> 

<marc:subfield code="a">Beschreibung basiert auf Website (gesehen am 

TT.MM.JJJJ)</marc:subfield> 

<marc:datafield tag="500" ind1=" " ind2=" "> 

<marc:subfield code="a">Archiviert durch die Schweizerische Nationalbiblio-

thek</marc:subfield> 

<marc:datafield tag="516" ind1=" " ind2=" "> 

<marc:subfield code="a">HTML</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="546" ind1="0" ind2=" "> 

<marc:subfield code="a">Text in: Deutsch, Englisch</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="659" ind1=" " ind2=" "> 

<marc:subfield code="a">Stichwort</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="710" ind1="2" ind2=" "> 
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<marc:subfield code="a">Körperschaft</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="856" ind1="4" ind2="0"> 

<marc:subfield code="u">Original-URL</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="856" ind1="4" ind2="2"> 

<marc:subfield code="u">http://www.e-helvetica.nb.admin.ch/directAc-

cess?callnumber=@URNID@</marc:subfield> 

<marc:subfield code="y">2</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="856" ind1="4" ind2=" "> 

<marc:subfield code="u">http://nbn-resolving.de/urn/re-

solver.pl?urn=urn:nbn:ch:@URNID@</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="992" ind1=" " ind2=" "> 

<marc:subfield code="a">xehelv</marc:subfield> 

<marc:subfield code="b">xwas</marc:subfield> 

<marc:subfield code="c">JJJJ</marc:subfield> 

<marc:subfield code="d">Dewey</marc:subfield> 

<marc:subfield code="e">Code für Lieferant/Kanton/Ereignis</marc:subfield> 

</marc:datafield> 

 

 

Version der Website (analog einer Zeitschriftennummer):  

 

<marc:leader>00253nym a22001214n 4500</marc:leader> 

<marc:controlfield tag="001"> 991001208299703976</marc:controlfield> 

<marc:controlfield tag="003">Sz</marc:controlfield> 

<marc:controlfield tag="004">991017984637303976</marc:controlfield> 

<marc:datafield tag="024" ind1="7" ind2=" "> 

<marc:subfield code="2">URN</marc:subfield> 

<marc:subfield code="a">urn:nbn:ch:@URNID@</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="245" ind1="0" ind2="0"> 

<marc:subfield code="a">Titel</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="264" ind1=" " ind2="1"> 

<marc:subfield code="a">Erscheinungsort :</marc:subfield> 

<marc:subfield code="b">Verlag</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="336" ind1=" " ind2=" "> 

<marc:subfield code="b">txt</marc:subfield> 

<marc:subfield code="2">rdacontent</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="337" ind1=" " ind2=" "> 

<marc:subfield code="b">c</marc:subfield> 

<marc:subfield code="2">rdamedia</marc:subfield> 

</marc:datafield> 

<marc:datafield tag="338" ind1=" " ind2=" "> 

<marc:subfield code="b">cr</marc:subfield> 

<marc:subfield code="2">rdacarrier</marc:subfield> 

</marc:datafield> 
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5.3 amdSec 

Die admSec ist in vier Bereiche aufgeteilt. Sie enthält den technischen und den rechtlichen Bereich 

der Metadaten, die Originalmetadaten und den Werdegang des Objektes.  

 

Die Sektion wird mit <amdSec> begonnen und mit </amdSec> abgeschlossen. 

 

5.3.1 techMD 

Die Preservation Metadata der National Library of Zealand (Version Juli 2003) werden für die techni-

schen Metadaten angewendet6 und die entsprechenden Regeln übernommen. 

 

Damit es keinen Konflikt mit der Codierung von METS und den Preservation Metadata der National 

Library of Zealand gibt, wird ein nlnz vor dem Elementnamen eingefügt. 

 

Obligatorische Elemente für alle Publikationstypen: 

 

<techMD ID="tmd0017"> 

<mdWrap MDTYPE="OTHER" OTHERMDTYPE="nlnz_presmet"> 

<xmlData> 

<nlnz:Object> 

 

 <nlnz:ID>003</ nlnz:ID> 

 <nlnz:Name>Titel (identisch mit marc:datafield tag="245" subfield  

 code="a")</nlnz:Name> 

 <nlnz:ReferenceNumber>NIL</nlnz:ReferenceNumber> 

 <nlnz:OriginalIdentifier>Y</nlnz:OriginalIdentifier> 

 <nlnz:PersistentIdentifier>urn:nbn:ch:@URNID@ 

 </nlnz:PersistentIdentifier> 

 <nlnz:MasterCreationDate> 

  <nlnz:Date>JJJJMMTT8</nlnz:Date> 

  <nlnz:Time>hhmmssss</nlnz:Time> 

 </nlnz:MasterCreationDate> 

 <nlnz:ObjectComposition>simple9</nlnz:ObjectComposition> 

 <nlnz:StructuralType> 

 <nlnz:Name>NIL</nlnz:Name> 

 <nlnz:Extension>NIL</nlnz:Extension> 

 </nlnz:StructuralType> 

 <nlnz:MetadataRecordCreator>Ingest NB</nlnz:MetadataRecordCreator> 

 <nlnz:MetadataCreationDate> 

  <nlnz:Date>JJJJMMTT</nlnz:Date> 

  <nlnz:Time>hhmmssss</nlnz:Time> 

 </nlnz:MetadataCreationDate> 

 <nlnz:Comments>eig</nlnz:Comments> 

 

Vor den Processen erfolgt die Angabe von <nlnz:Files> nach Bedarf (siehe weiter unten). 

 

 <nlnz:Processes> 

  <nlnz:Process> 

   <nlnz:Type>Originalcreator</nlnz:Type> 

                                                   

6 http://digitalpreservation.natlib.govt.nz/assets/NDHA/Reading/metaschema-revised.pdf 

7 Fortlaufende Identifikationsnummer: siehe unter Punkt 6.8 

8 Als Datum und Zeit wird überall das Erstellungsdatum des SLB-METS angegeben. 

9 Websites sind z.B. complex 

http://digitalpreservation.natlib.govt.nz/assets/NDHA/Reading/metaschema-revised.pdf
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   <nlnz:Process>URL</nlnz:Process> oder </nlnz:Process> 

   <nlnz:ProcessCreator>Lieferanten-ID</nlnz:ProcessCreator> 

  <nlnz:Permission>NIL</nlnz:Permission> 

  <nlnz:PermissionDate> 

  <nlnz:Date>JJJJMMTT</nlnz:Date> 

  <nlnz:Time>hhmmssss</nlnz:Time> 

  </nlnz:PermissionDate> 

  <nlnz:CompletionDate> 

   <nlnz:Date>JJJJMMTT</nlnz:Date> 

   <nlnz:Time>hhmmssss</nlnz:Time> 

  </nlnz:CompletionDate> 

  <nlnz:Comments>Name des Lieferanten</nlnz:Comments> 

 </nlnz:Process> 

 

<nlnz:Process> 

   <nlnz:Type>Request to collect</nlnz:Type> 

   <nlnz:Process>URL</nlnz:Process> 

   <nlnz:ProcessCreator>Ingest NB</nlnz:ProcessCreator> 

  <nlnz:Permission>NIL</nlnz:Permission> 

  <nlnz:PermissionDate> 

   <nlnz:Date>JJJJMMTT</nlnz:Date> 

   <nlnz:Time>hhmmssss</nlnz:Time> 

  </nlnz:PermissionDate> 

  <nlnz:Steps> 

   <nlnz:Step number="110"/> 

  </nlnz:Steps> 

  <nlnz:CompletionDate> 

   <nlnz:Date>JJJJMMTT</nlnz:Date> 

   <nlnz:Time>hhmmssss</nlnz:Time> 

  </nlnz:CompletionDate> 

<nlnz:Comments>Transfer-URL11</nlnz:Comments> 

 </nlnz:Process> 

 

 <nlnz:Process> 

   <nlnz:Type>E-Mail Rights</nlnz:Type> 

   <nlnz:Process>URL</nlnz:Process> 

   <nlnz:ProcessCreator>Lieferanten-ID</nlnz:ProcessCreator> 

  <nlnz:Permission>NIL</nlnz:Permission> 

  <nlnz:PermissionDate> 

   <nlnz:Date>JJJJMMTT</nlnz:Date> 

   <nlnz:Time>hhmmssss</nlnz:Time> 

  </nlnz:PermissionDate> 

  <nlnz:CompletionDate> 

   <nlnz:Date>JJJJMMTT</nlnz:Date> 

   <nlnz:Time>hhmmssss</nlnz:Time> 

  </nlnz:CompletionDate> 

  <nlnz:Comments>E-Mail-Adresse</nlnz:Comments> 

 </nlnz:Process> 

 

<nlnz:Process> 

  <nlnz:Type>Harvesting</nlnz:Type> 

                                                   

10 Pro Datei, die zu den Metadaten gesammelt werden muss, wird dieser Process wiederholt und die Zahl erhöht sich um 1.  

11 Hier wird die Abholadresse angegeben (Transfer-URL / FTP etc.) 
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  <nlnz:Process>URL</nlnz:Process> 

  <nlnz:ProcessCreator>Data Preservation NB</nlnz:ProcessCreator> 

  <nlnz:Permission>NIL</nlnz:Permission> 

  <nlnz:PermissionDate> 

   <nlnz:Date>JJJJMMTT</nlnz:Date> 

   <nlnz:Time>hhmmssss</nlnz:Time> 

  </nlnz:PermissionDate> 

  <nlnz:Steps> 

   <nlnz:Step number="1"/> 

  </nlnz:Steps> 

  <nlnz:Guidelines>every 3 months</nlnz:Guidelines>12 

  <nlnz:CompletionDate> 

   <nlnz:Date>JJJJMMTT</nlnz:Date> 

   <nlnz:Time>hhmmssss</nlnz:Time> 

  </nlnz:CompletionDate> 

  <nlnz:Comments>Kommentar aus dem Formular für das Webarchiv Schweiz: 

  was gesammelt werden sollte</nlnz:Comments> 

 </nlnz:Process> 

 

 <nlnz:Process> 

  <nlnz:Type>URL for URN registration</nlnz:Type> 

  <nlnz:Process>http://www.vollstaendige_url.ch</nlnz:Process> 

  <nlnz:Purpose>Master-URL13</nlnz:Purpose> 

  <nlnz:ProcessCreator>Ingest NB</nlnz:ProcessCreator> 

  <nlnz:Permission>NIL</nlnz:Permission> 

  <nlnz:PermissionDate> 

   <nlnz:Date>JJJJMMTT</nlnz:Date> 

   <nlnz:Time>hhmmssss</nlnz:Time> 

  </nlnz:PermissionDate> 

  <nlnz:CompletionDate> 

   <nlnz:Date>JJJJMMTT</nlnz:Date> 

   <nlnz:Time>hhmmssss</nlnz:Time> 

  </nlnz:CompletionDate> 

  <nlnz:Comments>urn:nbn:ch:bel-bau-diss8725414</nlnz:Comments 

 </nlnz:Process> 

 

 <nlnz:Process> 

  <nlnz:Type>URL for URN registration</nlnz:Type> 

  <nlnz:Process>http://www.e- 

  helvetica.nb.admin.ch/directAccess?callnumber=@URNID@</nlnz:Process> 

  <nlnz:Purpose>Frontpage-URL15</nlnz:Purpose> 

  <nlnz:ProcessCreator>Ingest NB</nlnz:ProcessCreator> 

  <nlnz:Permission>NIL</nlnz:Permission> 

  <nlnz:PermissionDate> 

   <nlnz:Date>JJJJMMTT</nlnz:Date> 

   <nlnz:Time>hhmmssss</nlnz:Time> 

  </nlnz:PermissionDate> 

  <nlnz:CompletionDate> 

   <nlnz:Date>JJJJMMTT</nlnz:Date> 

                                                   

12 Angabe, wie oft im Jahr die Publikation eingeholt werden sollte. 

13 Entspricht Frontpage oder Master-URL 

14 Falls keine URN dem URN-Resolver gemeldet werden sollte, wird ein Feld Comments mit der URN angegeben. 

15 Entspricht Archiv URL. 
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   <nlnz:Time>hhmmssss</nlnz:Time> 

  </nlnz:CompletionDate> 

  <nlnz:Comments>urn:nbn:ch:bel-bau-diss8725416</nlnz:Comments 

 </nlnz:Process> 

 

 

</nlnz:Object> 

</xmlData> 

</mdWrap> 

</techMD> 

 

Fakultative Elemente für alle Publikationstypen: 

 

<nlnz:HardwareEnvironment></nlnz:HardwareEnvironment> 

<nlnz:SoftwareEnvironment></nlnz:SoftwareEnvironment> 

<nlnz:InstallationRequirements></nlnz:InstallationRequirements> 

<nlnz:AccessInhibitors></nlnz:AccessInhibitors> 

<nlnz:Quirks></nlnz:Quirks> 

<nlnz:Comments></nlnz:Comments> 

 

<nlnz:Purpose></nlnz:Purpose> 

<nlnz:HardwareUsed></nlnz:HardwareUsed> 

<nlnz:SoftwareUsed></nlnz:SoftwareUsed> 

<nlnz:Steps></nlnz:Steps> 

<nlnz:Result></nlnz:Result> 

<nlnz:Guidelines></nlnz:Guidelines> 

<nlnz:Comments></nlnz:Comments> 

 

<nlnz:Modifications> 

 <nlnz:Modification> 

  <nlnz:Modifier>Data Preservation NB</nlnz:Modifier> 

  <nlnz:DateTime> 

   <nlnz:Date>JJJJMMTT</nlnz:Date> 

   <nlnz:Time>hhmmssss</nlnz:Time> 

  </nlnz:DateTime> 

  <nlnz:FieldModified>1.2</nlnz:FieldModified> 

  <nlnz:Data>Inhalt</nlnz:Data> 

 </nlnz:Modification> 

</nlnz:Modifications> 

 

 

Das Element „Files“ innerhalb von <nlnz:Object> wird pro Publikationstyp wie folgt vermerkt: 

 

Online-Zeitschrift/Reihe/Titel der Website: keine Angabe 

 

Online-Zeitschriftennummer/Online-Monografie/ Version der Website: 

 

<nlnz:Files> 

 <nlnz:Folder> 

  <nlnz:ID>1</nlnz:ID> 

  <nlnz:Path>Verzeichnisname</nlnz:Path> 

  <nlnz:Folder> 

                                                   

16 Falls keine URN dem URN-Resolver gemeldet werden sollte, wird ein Feld Comments mit der URN angegeben. 
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 ... 

  </nlnz:Folder> 

  <nlnz:File> 

   ... 

  </nlnz:File> 

 </nlnz:Folder> 

 <nlnz:File>17 

  <nlnz:FileIdentifier/> 

  <nlnz:Path>Verzeichnisname</nlnz:Path> 

  <nlnz:Filename> 

   <nlnz:Name>Dateiname</nlnz:Name> 

   <nlnz:Extension>pdf</nlnz:Extension> 

  </nlnz:Filename> 

  <nlnz:FormerFilename> 

   <nlnz:Name>Original-Dateiname</nlnz:Name> 

   <nlnz:Extension>pdf</nlnz:Extension> 

  </nlnz:FormerFilename> 

  <nlnz:Size>106872</nlnz:Size> 

  <nlnz:FileDateTime> 

   <nlnz:Date>JJJJMMTT</nlnz:Date> 

   <nlnz:Time>hhmmssss</nlnz:Time> 

  </nlnz:FileDateTime> 

  <nlnz:Mimetype>application/pdf</nlnz:Mimetype> 

  <nlnz:FileFormat> 

   <nlnz:Format>pdf</nlnz:Format> 

   <nlnz:Version>1.4</nlnz:Version> 

  </nlnz:FileFormat> 

  <nlnz:TargetIndicator>Y</nlnz:TargetIndicator> 

  <nlnz:Text>18 

   <nlnz:CharacterSet>UTF 8</nlnz:CharacterSet> 

  </nlnz:Text> 

 </nlnz:File> 

</nlnz:Files> 

 

Mit dem Element <nlnz:Folder> kann die Struktur der Dateien des digitalen Objekts aufgezeigt wer-

den, so dass dies für die Abbildung der Struktur genügt. 

 

File Section <nlnz:Version/> 

 

In dieser File Section können Angaben zur Version des jeweiligen Dateiformats gemacht werden. 

Zur Zeit können nicht alle Versionen von Dateiformaten, respektive Dateiformate erkannt werden, je-

doch sollte dies für PDF möglich sein und in den Metadaten in <nlnz:Version/> hinterlegt sein. Diese 

Information ist für das zukünftige Preservation Planning wichtig. 

 

File Section <nlnz:Format/> 

 

In dieser File Section können Angaben zum Dateiformat gemacht werden. 

Die Formate werden von Ingest aus dem Dokument-Header (MIMETYPE) dynamisch erkannt. 

 

 

                                                   

17 Das Element File wird pro Datei wiederholt. 

18 Falls die Online-Monografie z.B. ein Bild ist, kommt hier <image></image> 
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5.3.2 rightsMD 

Für die rechtlichen Metadaten werden Referenzdokumente mit Rechtssituationen erstellt. Im Element 

mdRef wird auf die URN-ID des entsprechenden Dokuments verwiesen. 

<rightsMD ID="rmd00119"> 

<mdRef MDTYPE="OTHER" LOCTYPE="URN" LABEL="access" xlink:href="http://nbn-

resolving.de/urn/resolver.pl?urn=urn:nbn:ch:bel-[rechtkat_1]"/> 

<mdRef MDTYPE="OTHER" LOCTYPE="URN" LABEL="archiving" 

xlink:href="file://[...]"/> 

</rightsMD> 

 

 

Archiv- und Zugriffsrechte 

 

Fehlende Rechte werden von Ingest e-Helvetica automatisch vergeben. Die vorhandenen Rechte 

müssen aber korrekt aufgeführt werden. Bei Dokumenten, die immer die gleichen Rechte haben, kann 

eine URN-ID in den Metadaten auf diese hinweisen. Jedes Dokument verfügt über eine eigene URN-

ID. 

 

Es sind folgende Rechte-Dokumente in der NB vorhanden: 

 

Zugriffsrechte 

 

o Im Internet: Die Publikation ist über den Bibliothekskatalog der Schweizerischen Nationalbibliothek 

frei zugänglich. 

o In den Publikumsräumen: Die Publikation ist über den Bibliothekskatalog der Schweizerischen Na-

tionalbibliothek nur innerhalb deren Räumlichkeiten zugänglich. 

o Keine Autorisierung: Die Publikation ist nicht zugänglich. 

 

Die Bezeichnungen für die Zugriffsrechte lauten: 

 

Frei 

Publikumsräume 

Gesperrt 

Gesperrt_Embargo 

 

Archivrechte 

 

Bei Websites unterschiedlicher Ersteller (Webarchiv Schweiz) müssen die Rechte bei jedem einzelnen 

neu geregelt werden. Sobald die Rechte eingeholt wurden, können sie als Datei geladen werden. Sie 

erscheinen bei den SIP Objekten als die Dateitypen Zugriffsrechte und Archivrechte. 

<slb> 

  <amdSec> 

    <rightsMD ID="rmd001"> 

      <mdRef LOCTYPE="URN" MDTYPE="OTHER" LABEL="access"  

                      xlink:href="http://localhost/access-

rights.txt"/> 

    </rightsMD> 

    <rightsMD ID="rmd002"> 

      <mdRef LOCTYPE="URN" MDTYPE="OTHER" LABEL="archiving"  

                      xlink:href="http://localhost/ar-

chivingrights.txt"/> 

    </rightsMD> 

  </amdSec> 

                                                   

19 Fortlaufende Identifikationsnummer: siehe unter Punkt 6.8 
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</slb> 

 

 

5.3.3 sourceMD 

Beim Container sourceMD wird in mdRef der Pfad zum File mit der Original-Metadatenlieferung ange-

geben. 

 

<sourceMD ID="smd00120"> 

<mdRef MDTYPE="OTHER" LOCTYPE="OTHER" LABEL="originalMetadata" 

xlink:href="Pfad zu Originalmetadatenlieferung"/> 

<mdRef MDTYPE="OTHER" LOCTYPE="URN" LABEL="originalMedium" xlink:href=" 

http://nbn-resolving.de/urn/resolver.pl?urn=urn:nbn:ch:bel-[trägerkat_1] 

"/> 

</sourceMD> 

 

 

Datenträgerbeschreibung 

 

Die Beschreibung der Datenträger ist in den Metadaten unter <sourceMD> zu finden: 

 

<sourceMD ID="smd001"> 

<mdRef MDTYPE="OTHER" LOCTYPE="URN" LABEL="originalMedium" 

xlink:href="http://nbn-resolving.de/urn/re-

solver.pl?urn=urn:nbn:ch:urn:nbn:ch:bel-27306"/> 

</sourceMD> 

 

Jeder Datenträger verfügt über eine eigene URN-ID. 

 

 

5.3.4 digiprovMD 

Der Werdegang ist im Container techMD, durch Process und Modification bereits abgedeckt und muss 

hier nicht nochmals erwähnt werden. 

 

 

5.4 fileSec 

Die fileSec wird nicht verwendet, da sich die technischen Metadaten bereits im Container techMD be-

finden.  

 

 

5.5 structMap 

Die structMap wird nicht ganz METS-konform verwendet. Hier werden die Hierarchien des Objekts ab-

gebildet, zu dem es gehört. Da in der NB für jedes AIP ein separater METS-Container erstellt wird, 

müssen hier nicht die Hierarchien innerhalb des METS-Containers abgebildet werden, sondern es 

werden die Hierarchien zwischen verschiedenen METS-Containern dargestellt. Dies wird über die Auf-

führung der Archiv-URL des Objekts sowie der in der Hierarchie nach oben zugehörigen Objekte ge-

macht. Beispielsweise werden in der structMap bei der Verzeichnung von Zeitschriftennummern die 

Zugehörigkeit zum Zeitschriftentitel vermerkt. Zusätzlich wird auch die eigene Archiv-URL vermerkt. 

 

                                                   

20 Fortlaufende Identifikationsnummer: siehe unter Punkt 6.8 



 

    

   20/21 

SLB METS 2.6 Version Internet 

 

Online-Zeitschrift:  

<structMap> 

<div> 

<mptr LOCTYPE="URL" OTHERLOCTYPE="zeitschrift" xlink:href="http://www.e-

helvetica.nb.admin.ch/directAccess?callnumber=bel-4332"/> 

</div> 

</structMap> 

 

Online-Reihe:  

<structMap> 

<div> 

<mptr LOCTYPE="URL" OTHERLOCTYPE="reihe" xlink:href="http://www.e-helvet-

ica.nb.admin.ch/directAccess?callnumber=bel-4332"/> 

</div> 

</structMap> 

 

Online-Zeitschriftennummer: 

<structMap> 

<div> 

<mptr LOCTYPE="URL" OTHERLOCTYPE="zeitschrift" xlink:href="http://www.e-

helvetica.nb.admin.ch/directAccess?callnumber=bel-4332"/> 

<div> 

<mptr LOCTYPE="URL" OTHERLOCTYPE="zeitschriftennummer" 

xlink:href="http://www.e-helvetica.nb.admin.ch/directAccess?callnumber=bel-

4578"/> 

</div> 

</div> 

</structMap> 

 

Migrierte Online-Zeitschriftennummer: 

<structMap> 

<div> 

<mptr LOCTYPE="URL" OTHERLOCTYPE="zeitschrift" xlink:href="http://www.e-

helvetica.nb.admin.ch/directAccess?callnumber=bel-4332"/> 

<div> 

<mptr LOCTYPE="URL" OTHERLOCTYPE="original-zeitschriftennummer" 

xlink:href="http://www.e-helvetica.nb.admin.ch/directAccess?callnumber=bel-

4578"/> 

<div> 

<mptr LOCTYPE="URL" OTHERLOCTYPE="kopie-zeitschriftennummer" 

xlink:href="http://www.e-helvetica.nb.admin.ch/directAccess?callnumber=bel-

102038"/> 

</div> 

</div> 

</div> 

</structMap> 



 

    

   21/21 

SLB METS 2.6 Version Internet 

 

Online-Monografie:  

<structMap> 

<div> 

<mptr LOCTYPE="URL" OTHERLOCTYPE="reihe" xlink:href="http://www.e-helvet-

ica.nb.admin.ch/directAccess?callnumber=bel-4332"/>21 

<div> 

<mptr LOCTYPE="URL" OTHERLOCTYPE="monografie" xlink:href="http://www.e-hel-

vetica.nb.admin.ch/directAccess?callnumber=bel-9235"/> 

</div> 

</div> 

</structMap> 

 

Titel der Website: 

<structMap> 

<div> 

<mptr LOCTYPE="URL" OTHERLOCTYPE="website" xlink:href="http://www.e-helvet-

ica.nb.admin.ch/directAccess?callnumber=bel-4332"/> 

</div> 

</structMap> 

 

Version der Website: 

<structMap> 

<div> 

<mptr LOCTYPE="URL" OTHERLOCTYPE="website" xlink:href="http://www.e-helvet-

ica.nb.admin.ch/directAccess?callnumber=bel-4332"/> 

<div> 

<mptr LOCTYPE="URL" OTHERLOCTYPE="versionwebsite" xlink:href="http://www.e-

helvetica.nb.admin.ch/directAccess?callnumber=bel-4578"/> 

</div> 

</div> 

</structMap> 

 

 

5.6 structLink 

Das Element structLink wird nicht verwendet. 

 

 

5.7 behaviorSec 

Die behaviorSec wird nicht verwendet.  

 

 

5.8 Bemerkung zur ID 

Durch den gesamten METS-Container hindurch wird eine ID verlangt. Bei structMap wird eine schon 

benützte ID verlangt, sonst jeweils eine neue. Da diese ID obligatorisch ist, wird eine fortlaufende Zahl 

eingefügt. Wenn bei structMap eine ID eingegeben wird, muss eine bereits im Datensatz benutzte an-

gegeben werden.  

                                                   

21 Wenn vorhanden. 


